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© 2006 ZIH Corp.   The copyrights in this manual and the software and/or firmware in the label printer 
described therein are owned by ZIH Corp. Unauthorized reproduction of this manual or the software and/or 
firmware in the label printer may result in imprisonment of up to one year and fines of up to $10,000 
(17 U.S.C.506). Copyright violators may be subject to civil liability.

This product may contain ZPL®, ZPL II®, and ZebraLink™ programs; Element Energy Equalizer® Circuit; 
E3®; and Monotype Imaging fonts. Software © ZIH Corp. All rights reserved worldwide.

ZebraLink and all product names and numbers are trademarks, and Zebra, the Zebra logo, ZPL, ZPL II, Element 
Energy Equalizer Circuit, and E3 Circuit are registered trademarks of ZIH Corp. All rights reserved worldwide.

All other brand names, product names, or trademarks belong to their respective holders. For additional 
trademark information, please see “Trademarks” on the product CD.

Proprietary Statement  This manual contains proprietary information of Zebra Technologies Corporation 
and its subsidiaries (“Zebra Technologies”). It is intended solely for the information and use of parties operating 
and maintaining the equipment described herein. Such proprietary information may not be used, reproduced, or 
disclosed to any other parties for any other purpose without the express, written permission of Zebra 
Technologies Corporation.

Product Improvements  Continuous improvement of products is a policy of Zebra Technologies 
Corporation. All specifications and designs are subject to change without notice.

Liability Disclaimer  Zebra Technologies Corporation takes steps to ensure that its published Engineering 
specifications and manuals are correct; however, errors do occur. Zebra Technologies Corporation reserves the 
right to correct any such errors and disclaims liability resulting therefrom.

Limitation of Liability  In no event shall Zebra Technologies Corporation or anyone else involved in the 
creation, production, or delivery of the accompanying product (including hardware and software) be liable for 
any damages whatsoever (including, without limitation, consequential damages including loss of business 
profits, business interruption, or loss of business information) arising out of the use of, the results of use of, or 
inability to use such product, even if Zebra Technologies Corporation has been advised of the possibility of such 
damages. Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.

Part Number: 13991L-001 Rev. A
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Please read the terms of this “End User License Agreement” (the “Agreement”) carefully.  The 
Agreement is a legal agreement between you (either an individual or a single entity) and Zebra 
Technologies International, LLC (“Zebra”) for the Zebra computer software and/or firmware 
accompanying this End User License Agreement, and any associated media, printed materials 
and any “online” or electronic documentation (collectively, “Software”).  By installing or 
using the Software, you agree to be bound by the terms of this Agreement.  If you do not agree 
to the terms of this Agreement, you may not install or use the Software.  

1.  Grant of License.   The Software is protected by copyright and other intellectual 
property laws and international treaties.  The Software is licensed to you, and not sold, subject 
to the terms of this Agreement.  Subject to the terms of this Agreement, Zebra hereby grants 
you a limited, personal, non-exclusive license during the term of this Agreement to use the 
Software solely and exclusively for your internal use for the operation of your associated 
Zebra printer(s) and for no other purpose.  To the extent that any portion of the Software is 
provided to you in a manner that is designed to be installed by you, you may install one copy 
of the installable Software on one hard disk or other storage device for one printer, computer, 
workstation, terminal, or other digital electronic device, as applicable (an “Electronic 
Device”), and you may access and use that Software as installed on that Electronic Device so 
long as only one copy of such Software is in operation.  If you are an organization rather than 
an individual, you may authorize personnel associated with your business to use the Software, 
but only one person at a time on one Electronic Device at a time.  You agree not to duplicate or 
copy the Software, except that you may make one back-up copy for archive purposes.  The 
primary user of the Electronic Device on which installable Software is installed may also make 
a copy for his or her exclusive use on a portable computer, so long as such Software is being 
used only on one Electronic Device at a time.   

2.  Storage/Network Use.  In the alternative, you may install a copy of the Software on a 
storage device, such as a network server, used only to access and use the Software on your 
Electronic Devices over an internal network; however, you must acquire and dedicate a license 
for each separate Electronic Device on which the Software is accessed and used from the 
storage device.  A license for the Software may not be shared or used concurrently on different 
Electronic Devices.  



3.  Documentation.  If the Software contains documentation which is provided only in 
electronic form, you may print one copy of such electronic documentation.  You may not copy 
the printed materials accompanying the Software.

4.  Limitations of Reverse Engineering, Decompilation and Disassembly.  You 
may not reverse engineer, decompile, or disassemble the Software, except and only to the 
extent that such activity is permitted by applicable law notwithstanding this limitation.

5.  Transfer/Sublicense.  You may not transfer, sublicense, distribute, rent, lease, supply, 
market or lend the Software to any other party.  

6.  Confidentiality.  You acknowledge that the Software embodies confidential information 
owned by Zebra and/or its suppliers and licensors.  To the extent you have access to any such 
information, you agree to use such information only for the authorized use of the Software.  
You further agree not to disclose such confidential information to any other party and to use at 
least the same degree of care to maintain the confidential nature of such information as you use 
to maintain the confidentiality of your own confidential information.

7.  Intellectual Property.  All title, copyrights and other intellectual property rights in and 
to the Software (including but not limited to copyrights, patents, trade secrets and trademarks) 
are owned by Zebra or its suppliers and licensors.  You must maintain all copyright notices on 
all copies of the Software.  All rights not expressly granted are reserved by Zebra.  Without 
prejudice to any rights or remedies Zebra may have for your violation of this Software 
License, Zebra shall own all changes or modifications to the Software.  

8.  Termination.  Without prejudice to any other rights or remedies Zebra may have, Zebra 
may terminate this Agreement if you fail to comply with the terms and conditions of this 
Agreement.  Zebra may terminate this Agreement by offering you a superseding Agreement 
for the Software or any replacement or modified version of or upgrade to the Software and 
conditioning your continued use of the Software or such replacement, modified or upgraded 
version on your acceptance of such superseding Agreement.  In addition, either party may 
terminate this Agreement at any time.  Subject to the foregoing, termination shall be effective 
upon notice to the other party.  In the event that this Agreement terminates for any reason, your 
license to use the Software will terminate, and you must immediately stop using the Software, 
destroy all copies of the Software and all of its component parts, and, upon request, provide an 
affidavit certifying your compliance with the foregoing.  The provisions of Sections 4, 5, 6, 7, 
12, 13, 14, 15, 16, 17, 18, 19 and 20 shall survive termination of this Agreement.

9.  U.S. Government Restricted Rights.  All Software provided to the U.S. Government 
pursuant to solicitations issued on or after December 1, 1995 is provided with the commercial 
rights and restrictions described elsewhere herein.  All Software provided to the U.S. 
Government pursuant to solicitations issued prior to December 1, 1995 is provided with 
RESTRICTED RIGHTS as provided for in FAR, 48 CFR 52.227-19 (JUNE 1987) or DFARs, 
48 CFR 252.227-7013 (OCT 1988), as applicable.



10.  Export Restrictions.  You agree that you will not export or re-export the Software, any 
part thereof, or any process or service that is the direct product of the Software (the foregoing 
collectively referred to as the “Restricted Components”), to any country, person or entity 
subject to U.S. export restrictions.  You specifically agree not to export or re-export any of the 
Restricted Components: (i) to any country to which the U.S. has embargoed or restricted the 
export of goods or services, which currently include but are not necessarily limited to Cuba, 
Iran, Iraq, North Korea, Sudan and Syria, or to any national of any such country, wherever 
located, who intends to transmit or transport the Restricted Components back to such country; 
(ii) to any person or entity who you know or have reason to know will utilize the Restricted 
Components in the design, development or production of nuclear, chemical or biological 
weapons; or (iii) to any person or entity who has been prohibited from participating in U.S. 
export transactions by any federal agency of the U.S. government.  You warrant and represent 
that neither the U.S. Commerce Department, Bureau of Export Administration nor any other 
U.S. federal agency has suspended, revoked or denied your export privileges.   
Contractor/Manufacturer is Zebra Technologies Corporation, 333 Corporate Woods Parkway, 
Vernon Hills, Illinois  60061.  

11.  Accessing Services Using the Software.  Your use of any service accessible using 
the Software is not covered by this EULA and may be governed by separate terms of use, 
conditions or notices.  Zebra and its suppliers and licensors hereby disclaim any such liability 
for any such services accessed.

12.  Disclaimer.  ZEBRA SUPPLIES THE SOFTWARE AS IS AND WITH ALL FAULTS 
AND DOES NOT MAKE ANY WARRANTIES WHATSOEVER, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO WARRANTIES CONCERNING THE SOFTWARE 
OR ANY APPLICATION, OPERATION OR USE THEREOF, THE OUTPUT OR THE 
DATA GENERATED BY THE OPERATION OR USE THEREOF, OR ANY SUPPORT 
SERVICES RENDERED WITH RESPECT THERETO. ZEBRA HEREBY EXCLUDES 
ALL IMPLIED WARRANTIES TO THE MAXIMUM EXTENT AUTHORIZED BY LAW, 
INCLUDING, SPECIFICALLY, ANY IMPLIED WARRANTY ARISING BY STATUTE OR 
OTHERWISE IN LAW OR FROM A COURSE OF DEALING OR USAGE OF TRADE, 
ALL IMPLIED WARRANTIES OF MERCHANTABILITY, OR OF MERCHANTABLE 
QUALITY, OR OF FITNESS FOR ANY PURPOSE, PARTICULAR, SPECIFIC OR 
OTHERWISE, OR OF TITLE, OR OF NONINFRINGEMENT.  SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES, SO 
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.  WHEN THE 
IMPLIED WARRANTIES ARE NOT ALLOWED TO BE EXCLUDED IN THEIR 
ENTIRETY, THEY WILL BE LIMITED TO THE DURATION OF NINETY (90) DAYS.  
WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, ZEBRA DOES NOT 
WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED 
OR ERROR FREE.  To the extent that the Software covered by this EULA includes emulation 
libraries, such emulation libraries do not work 100% correctly or cover 100% of the 
functionality of the printer language being emulated, are offered “as is” AND WITH ALL 
FAULTS, AND ALL THE DISCLAIMERS AND LIMITATIONS CONTAINED IN THIS 
PARAGRAPH AND THIS AGREEMENT APPLY TO SUCH EMULATION LIBRARIES.  



13.  Limitation of Liability and Damages.  ZEBRA DOES NOT ASSUME 
RESPONSIBILITY FOR ANY SPECIFIC APPLICATION OF THE SOFTWARE OR FOR 
COMPATIBILITY WITH OTHER SOFTWARE OR EQUIPMENT.  TO THE FULL 
EXTENT ALLOWED BY LAW, ZEBRA EXCLUDES FOR ITSELF AND ITS LICENSORS 
AND SUPPLIERS ANY LIABILITY FOR ANY DAMAGES, INCLUDING WITHOUT 
LIMITATION DIRECT, CONSEQUENTIAL, INCIDENTAL, INDIRECT, SPECIAL, 
EXEMPLARY OR PUNITIVE DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE 
OR PROFITS, LOSS OF BUSINESS, DAMAGE TO GOODWILL, LOSS OF 
INFORMATION OR DATA, OR OTHER FINANCIAL LOSS ARISING OUT OF OR IN 
CONNECTION WITH THE SALE, INSTALLATION, MAINTENANCE, USE, 
PERFORMANCE, FAILURE, OR INTERRUPTION OF ANY PRODUCTS, PARTS OR 
SOFTWARE, WHETHER BASED ON CONTRACT, TORT, NEGLIGENCE, STRICT 
LIABILITY OR OTHERWISE, EVEN IF ZEBRA OR ANY LICENSOR OR SUPPLIER 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  TO THE 
MAXIMUM EXTENT AUTHORIZED BY LAW, THIS DISCLAIMER OF LIABILITY 
FOR DAMAGES WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN 
SHALL FAIL OF ITS ESSENTIAL PURPOSE.  SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OR LIMITATION OF DIRECT, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU.  WHEN LIABILITY FOR DAMAGES IS NOT 
ALLOWED TO BE LIMITED OR EXCLUDED IN ITS ENTIRETY, ZEBRA LIMITS ITS 
LIABILITY TO REPAIR, REPLACEMENT, OR, AT ZEBRA’S OPTION, REFUND OF THE 
PRICE OF THE SOFTWARE.

14.  Zebra Suppliers and Licensors.  Any release, disclaimer or limitation of Zebra’s 
liability or damages pursuant to this Agreement shall be construed, in addition to Zebra’s 
benefit, also to the benefit of Zebra’s suppliers, licensors, employees, and contractors and, 
without limiting any other defenses that such suppliers, licensors, employees and contractors 
may have, you agree to release such parties from liability or damages in accordance with such 
release, disclaimer, or limitation of liability or damages to the same extent that such provisions 
apply to Zebra.  

15.  Governing Law.   To the maximum extent permitted by law, the laws of the State of 
Illinois, U.S.A., without reference to its conflict of laws provisions, will apply to this 
Agreement.  You irrevocably agree to submit to the exclusive jurisdiction and venue of the 
state or federal courts in the State of Illinois in the event of any litigation involving this 
Agreement or the Software.  You agree that you shall not assert any claim that you are not 
subject to the jurisdiction of such courts, that the venue is improper, that the forum is 
inconvenient or any similar objection, claim or argument.  Zebra may, in its sole discretion, 
choose to resolve any controversy or dispute between you and Zebra concerning this 
Agreement, or the existence, validity, breach or termination thereof, whether during or after 
the term by binding arbitration in accordance with the Commercial Arbitration Rules of the 
American Arbitration Association (“AAA”), as modified or supplemented under this Section 
15, by providing notice to you. In the event that Zebra provides such notice, you hereby waive 
any right to institute a court or other dispute resolution proceeding with respect to such 
controversy or dispute and acknowledge arbitration in accordance with this Section 15 as the 
sole and exclusive means of resolving such controversy or dispute. The arbitration proceeding 
will take place in Chicago, Illinois and be conducted in the English language. The arbitration 
panel will consist of 3 arbitrators, one arbitrator appointed by each party and a third neutral 
arbitrator appointed by the two arbitrators designated by the parties. Any communication 



between a party and any arbitrator will be directed to the AAA for transmittal to the arbitrator. 
The parties expressly agree that the arbitrators will be empowered to, at either party’s request, 
grant injunctive relief. The arbitral award will be the exclusive remedy of the parties for all 
claims, counterclaims, issues or accountings presented or pleaded to the arbitrators. Judgment 
upon the arbitral award may be entered in any court that has jurisdiction thereof. Any 
additional costs, fees or expenses incurred in enforcing the arbitral award will be charged 
against the party that resists its enforcement. Nothing in this Section will prevent Zebra from 
seeking interim injunctive relief against you or filing an action against you to collect unpaid 
and past due amounts in any court of competent jurisdiction.

16.  Injunctive Relief.  You acknowledge that, in the event you breach any provision of this 
Agreement, Zebra will not have an adequate remedy in money or damages.  Zebra shall 
therefore be entitled to obtain an injunction against such breach from any court of competent 
jurisdiction immediately upon request without posting bond.  Zebra's right to obtain injunctive 
relief shall not limit its right to seek further remedies.

17.  Entire Agreement.  This Agreement constitutes the entire understanding and 
agreement of the parties and supersedes any and all prior or contemporaneous representations, 
understandings and agreements between the parties with respect to the subject matter of this 
Agreement.  If any provision of this Agreement is held invalid, the remainder of this 
Agreement shall continue in full force and effect.

18.  Assignment.  You may not assign this Agreement or any of your rights or obligations 
hereunder (by operation of law or otherwise) without the prior written consent of Zebra.  Zebra 
may assign this Agreement and its rights and obligations without your consent.  Subject to the 
foregoing, this Agreement shall be binding upon and inure to the benefit of the parties to it and 
their respective legal representatives, successors and permitted assigns.

19.  Modification.  No modification of this Agreement shall be binding unless it is in writing 
and is signed by an authorized representative of the party against whom enforcement of the 
modification is sought.

20.  Waiver.  The failure by a party to exercise any right hereunder shall not operate as a 
waiver of such party's right to exercise such right or any other right in the future.

21.  OUESTIONS.  Should you have any questions, or if you desire to contact Zebra for any 
reason, please contact the Zebra subsidiary serving your country, or write:

Zebra Technologies International, LLC
333 Corporate Woods Parkway
Vernon Hills, Illinois 60061

Effective February 2006.  
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Introduction 

Welcome 
ZebraDesigner software is a family of labeling software products that provides a complete bar 
code and RFID Smart Label printing solution for desktop users. ZebraDesigner has an easy-
to-use interface and meets any label design and printing requirement for efficient label 
printing solutions for users in retail, logistics, health care, chemical, automotive, and other 
industries. 

ZebraDesigner can be used with any 32-bit Windows® operating system: Windows 98 SE, 
Windows NT® 4.0, Windows ME, Windows 2000, Windows XP, and Windows Server ™ 
2003. 

You can use ZebraDesigner for XML to design your label templates, export the templates, 
and parse them through the XML Format Generation Wizard. The resulting label templates 
are used for off-line label printing with data from different applications. 
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Contents of the package 
Before installing ZebraDesigner for XML, check the contents of the package to ensure it is 
complete. The package should include the ZebraDesigner CD. 

If any of the mentioned items are missing, please contact your software vendor immediately 
for package replacement. 
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About this Manual 
The ZebraDesigner for XML User Guide helps you design and print labels quickly. 

The User Guide contains the following sections: 

Introduction: This chapter introduces you to ZebraDesigner for XML. 

Installation and Activation: This chapter shows you how to install and activate the labeling 
software. 

Set up ZebraDesigner: This chapter shows you how to set up and customize software to 
your preferences. 

Design Labels: This chapter shows you how to create labels. You should refer to this chapter 
regularly while designing labels, until you have completely familiarized yourself with the 
commands. By using the information contained in this chapter, you will be able to use 
labeling software quickly and efficiently. 

Export Labels: This chapter shows you how to print and preview labels. 

Interface Reference: This chapter describes details and explains all the commands used in 
the labeling software (available in the help file only). 

Technical Support: This chapter provides information on how to contact technical support. 

Glossary of Terms: This chapter describes some of the technical terms used in the document. 
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Typographical Conventions 
Bold text refers to: 

• menu names 

• file names (SETUP.EXE) 

• interface buttons (OK) 

• PC keyboard keys (Alt) 

• menu flows (menu flows have a > that separates one menu from the next menu, for 
example Start > Programs > ZebraDesigner for XML) 

Italic text refers to: 

• graphic captions 

• text you need to type 

• locations  

• dialog box names 

 

 

 



 

5 

Installation and Activation 

System and Software Requirements 
These are the minimum requirements needed to run ZebraDesigner for XML: 

• Pentium®-based computer with at least 64 MB of RAM 

• One of the 32-bit Windows operating system: Windows 98 SE, Windows NT 4.0, 
Windows ME, Windows 2000, Windows XP, and Windows Server 2003 

• Hard disk with 75 MB of free disk space 

• CD-ROM drive 

• Administrator rights to the local computer during installation 



ZebraDesigner for XML User Guide 

6 

Install Overview for ZebraDesigner for XML 
When you put the ZebraDesigner for XML CD in your CD-ROM drive, the 
installation/demonstration program automatically starts. You can browse the directory of the 
CD and look at the brochures, technical documentation, sample files, and other documents on 
the CD. 

Note: If you are using Windows NT, Windows 2000, Windows XP, or Windows Server 
2003 you have to log on with Administrator rights to perform the installation. 

Close All Software Applications 
Before you start installing ZebraDesigner for XML, close all other software applications. This 
ensures a complete installation of ZebraDesigner for XML. 

Run Installation 
To install ZebraDesigner for XML on your desktop PC, do the following: 

1. Insert the ZebraDesigner for XML CD into your CD-ROM drive. The Setup Wizard 
dialog box opens. 

Note: If the Setup Wizard does not start automatically, go to the main CD directory of 
your ZebraDesigner for XML CD and double-click START.EXE. 

2. Click Next. 

3. Follow the prompts and make your selections accordingly. 

4. Click Install.  

5. Click Finish.  
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Define Setup Options 
To continue the installation, do the following: 

1. Click Next. 

2. Specify the program group you want to use for ZebraDesigner for XML. 

3. Specify if shortcuts to ZebraDesigner for XML should be created on the desktop or in 
the Quick Launch area. 

4. To finish the installation, click Install. 
 
After installation you are asked to install a printer driver. You must install a 
ZebraDesigner driver. If you do not install a printer driver while installing the 
software, you are asked to install one the first time you run the program. 

5. After the installation is complete, the Start menu in Windows shows a new program 
group for ZebraDesigner for XML. The program group contains shortcuts for all 
ZebraDesigner for XML applications. 

Install Printer Driver 
To install the ZebraDesigner printer driver on your computer, do the following: 

1. Click Start > Programs > ZebraDesigner for XML. 

2. In the group ZebraDesigner for XML, click the shortcut Add printer. The printer 
installation wizard starts. 

3. Follow the prompts. 
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Register ZebraDesigner for XML 
To activate all of the features of ZebraDesigner for XML, you need to register the product. If 
you do not complete the registration process, ZebraDesigner for XML runs in DEMO mode 
only. 

Note: ZebraDesigner does not require registration. It is free software, but available with 
less functionality than ZebraDesigner for XML. 

To register the software, do the following: 

1. Start ZebraDesigner for XML. The DEMO dialog box opens. 

2. Click Register. 

3. Enter the required information and follow the prompts. 

ZebraDesigner for XML Demo Mode 
When ZebraDesigner for XML is running in the demo mode, it has limited functionality. The 
major limitation of ZebraDesigner for XML demo mode is that two text objects with the 
contents DEMO are added to each printed label. 

You should use the DEMO version only to evaluate ZebraDesigner for XML. Any 
commercial use of the DEMO version is prohibited. To get a full working version of 
ZebraDesigner for XML, you must purchase and register the software. 
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Set Up the ZebraDesigner Software 

User Interface 
This is the ZebraDesigner for XML main dialog box. 

 
ZebraDesigner for XML user interface 

Mouse Wheel Support 
If you have a mouse that has a wheel in place of the middle button, you can use it to speed up 
zooming and scrolling: 

• Turning the wheel scrolls the label up or down 

• Holding Shift and turning the wheel scrolls the label left or right 

• Holding Ctrl and turning the wheel zooms the label in or out 



ZebraDesigner for XML User Guide 

10 

Shortcuts 

Delete Delete selected object 

Ctrl + X Cut 

Ctrl + C Copy 

Ctrl + V Paste 

Alt + Backspace Undo 

+ (on numeric pad) Zoom In 

- (on numeric pad) Zoom Out 

Alt + Shift + Backspace Redo 

Ctrl + T Rotate 90° 

Ctrl + A Align 

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + N New 

Ctrl + O Open 

Ctrl + S Save 

Ctrl + F4 Close 

Ctrl + Alt + T  Test print 

Ctrl + G Snap to grid 

Ctrl + move the object with 
mouse 

Move the object by main axes only 

Alt + move the object with 
mouse 

Snap to grid even if it is off 

Ctrl + move the object with 
cursor keys 

Fine-tune the position of the object 

Shift + cursor keys Fine-tune the dimensions of the object, resize width and 
height in very small steps 
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Right-clicking the 
object 

Open pop-up menu with shortcuts to commands. The content of 
the pop-up menu depends on where you clicked your mouse 
button and what was selected at that time 

Enter F2 or 

double-click 
Open properties dialog box of the selected element 

Shift + resizing of 
the variable text 
object 

Resize the frame text container 
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Using the Keyboard and Mouse Effectively 
• When selecting objects, you can use the Ctrl key to adjust the object's anchoring point 

by clicking the object placeholders. 

• If you have a wheel mouse, you can use the wheel to scroll the label up and down. 
Simultaneously holding the Ctrl key and rotating the wheel adjusts the zoom factor. 
Simultaneously holding the Shift key and rotating the wheel scrolls the label from left 
or right. 

• You can set various options for the currently selected printer. To do so, in the status 
bar, double-click the printer's name to open the Printer Properties dialog box. To 
select a different printer, hold the Ctrl key while double-clicking. The Printer Setup 
dialog box opens and you can select a different printer. 

• You can quickly move objects from one open label to another by dragging the desired 
object to another window while holding the Alt key. If you want to copy objects 
instead, hold both the Alt and Ctrl keys. Note that you must have both label dialog 
boxes visible to do so. 

• You can select different objects on a label using the Tab key and the Shift +Tab keys. 

• You can move selected objects by pressing the cursor keys while holding the Ctrl key. 
You can use this to fine-tune the position of the object. Holding Shift while pressing 
cursor keys resizes the object. 

• You can use the right mouse button almost anywhere on the label to access the most 
common options for that area/object. For example, if you click an object with the right 
mouse button, a pop-up menu appears that contains actions that can be performed on 
the selected object. Similarly, clicking other parts of the label produces pop-up menus 
with options for that part of the label. 

• You can select multiple objects by holding Shift while clicking the objects. 
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System folder 
The labeling application uses its system folder for storing files needed to run the program. 
The location of the folder varies depending on the Windows operating system, as follows: 

• On Windows 98 and Windows ME, the location is C:\Program Files\ZebraDesigner 
for XML\Bin\System.  

• On Windows NT, Windows 2000, and Windows XP, the location is C:\Documents 
and Settings\All Users\Application Data\Zebra\ZebraDesigner for XML. 

It is important to have write/modify access to this folder on your computer system. 

In these files, user data and user rights are stored, as well as custom settings, variable trace 
logs, label usage logs, variable definition files *.NVR, stock file database, and bar code 
standards. 

Welcome Wizard 
When you start the application, a Welcome Wizard dialog box opens. It provides a quick 
access to the most frequently used commands when starting to work on a label layout. 

Create a new label A blank label opens and the Label Setup Wizard starts. You can 
then design a new label from scratch. 

Open recently used 
label 

A list of recently used labels opens to provide quick access to 
commonly used labels. 

Open some other 
existing label 

A common Windows dialog box opens to let you browse for the 
appropriate label file. 
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Design Labels 

Overview 
This section shows you how to design a label file with fixed and variable objects. The 
variable objects get values from several sources. You learn how to: 

• Place objects on the label 

• Link objects to the variables 

• Preview the label on the screen 

The label you create will look like this: 

 
Basic label 

Create a Basic Label 
Each time you create a new label, the Label Setup Wizard starts to help you set up the label 
and connect to the printer. 

To create a basic label, do the following: 

1. Open ZebraDesigner for XML. 

2. In the Standard toolbar, click . The Label Setup Wizard dialog box opens. 

Note: To exit the Label Setup Wizard dialog box, click Finish. 



Design Labels 

15 

Select a Printer 

To select a printer, do the following: 

1. From the menu, select File > Label Setup. 

2. Select the printer you want to use for label printing. 

Note: If you don’t find your printer on the list, see Install Printer Driver for 
installation instructions. 

 
Selecting a printer 

3. Click Next.  
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Define Label and Page Dimensions 

To define the label dimensions, do the following: 

1. If you want to use label stock, make your selections in the Select Stock dialog box.  

2. Click Next. The Page Size dialog box opens to define the label dimensions. 

3. Leave the Page size option at User defined default, and check Automatic Sizing.  

4. Click Next. The Label Layout dialog box opens. 

 
Selecting label layout 

5. Select label orientation and print direction. 

6. Click Next. The Label Dimensions dialog box opens. 

Note: The Label Dimensions dialog box differs for thermal and office printers.  
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Defining label dimensions 

7. Enter 10 for label width and 7 for label height. 

Note: To change the unit of measure from centimeters to inches or other supported 
units, click Unit of measure below the label preview. 

8. Click Finish. A new empty label opens. 
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Enter Fixed Text 

1. In the Toolbox, click . The text cursor appears on the screen. 

 
Cursor for text object 

2. Move the cursor to the location on the label where you want to place the text object, 
and click the mouse button. The Text Object dialog box opens. 

 
Entering content for text object 

3. In the text box, type SAMPLE. 

4. Click Finish. 

5. To select the object, click it. 

6. Using the Text toolbar, change the font for the text object. Choose Arial font, 28 point 
size, and bold style. 
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Using format options in the Text toolbar 

7. To change the position and size of the text object, select the text object and drag it 
with your mouse to the position you want. 

The screen should show the following: 

 
The text object is placed on the label 
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Insert Bar Codes 

To add a non-changeable Code128 bar code on the label, do the following. 

1. In the Toolbox, click . 

2. Move the cursor to the desired position on the label and then click the mouse button. 
The dialog box with object properties opens. 

3. Enter the value 1234567890 for the bar code contents. 

4. Click Define. The Edit Bar Code dialog box opens. 

 
Selecting bar code type 

5. In the Available bar codes list, select bar code Code128 and then click OK. 

6. To return to the label, click Finish. 

7. To change the position of the bar code, select the bar code and drag it to the desired 
position. 

8. To change the object size, drag the object handles. The handles are small rectangles 
surrounding the object when it is selected. 
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The label should now show the following: 

 
Label with text and bar code objects 

Insert Pictures 

ZebraDesigner for XML works with BMP, PCX, GIF, WMF, JPEG, and many other popular 
graphic formats. 

To insert a picture, do the following: 

1. In the Toolbox, click . 

2. Move the cursor to the desired position on the label and click the mouse button. The 
Open dialog box opens allowing you to browse for a picture on your hard drive.  

3. From the Graphics Kind dialog box, click Browse.  

4. Go to the Sample Graphics folder and select LEISURE.WMF.  

5. Click Open. 

The screen should show the following: 

 
Label with text, bar code, and picture objects 
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Save a Label 

Always save your label during the design process.  

To save a label, do the following:  

1. In the Standard toolbar, click . 

2. Type in the name of the label. For example, type label for the name of the label. 
The name of the label appears in the program caption. 

Use Alignment Tools 

Once you place the objects on the label make sure they are aligned on the horizontal center of 
the label. You can align objects on the label by using the Align toolbar on the right side of the 
working window. 

To align objects on the label, do the following: 

1. In the Toolbox, click . 

2. To select all of the objects, draw a frame around all of them. 

Note: The first object you select determines the alignment orientation for all selected 
objects. 

 
Selecting the objects on the label 

3. To arrange the objects, in the Align toolbar on the right, click . The selected 
objects are rearranged and positioned on the center of the label. 

Note: 
 
• The Align toolbar has other alignment commands available. 
 
• You can also align the objects to the label grid. The Snap to Grid option is available in 
the View menu. 
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Use Drawing Tools 

To insert a line to separate a text object from other objects and a rectangle around the picture 
object, do the following: 

1. From the Toolbox, click  and move the cursor to the required starting 
point of the line. 

2. While drawing the line, press and hold down the mouse button. Move the mouse to the 
end position of the line and release the button. The Line object is placed on the label. 

3. In the Toolbox, click  and point the mouse to the upper left corner of 
the picture. 

4. While you stretch the rectangle to the lower right corner of the picture, click and hold 
the mouse button. 

5. To change the thickness of the vertical and horizontal line, double-click on the 
rectangle object to open its properties.  

6. Select the thickness you want. 

7. Click Finish. 

8. To edit the drawing object, double-click on the line or rectangle to open the dialog box 
with its properties. 

The label should show the following: 

 
Label with fixed objects 
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Add Variable Fields 
If you want to print a label on which the data changes for each label, ZebraDesigner for XML 
offers different variable fields (date/time fields, link to the variables) that you can use with 
text, picture, and bar code objects. 

For this example, a new label was created. The steps in the following topics explain how to 
create a label that contains a variable field and date/time fields.  

Create Variable Fields linked to Variables 

The object on the label that is linked to the variable can have a different value for each printed 
label. 

To create a text object linked to the variable, do the following: 

1. In the Toolbox, click . 

2. Click the label where you want to place the text object. The Text Wizard dialog box 
opens. 

3. For the Contents, select Variable text. 

4. Click Next. 

5. Select Variable Field. 

6. Click Next. 

7. Select one of the existing variables in the list. If no variable is available in the list, you 
must create some.  

8. Click Finish. The text object is placed on the label and linked to the selected variable. 

Note: This example shows how to create a text field linked to the variable. You can use 
the same approach to create and link a variable to the bar code object. 
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Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or time stamp from the 
computer clock or printer clock (for supported printer models). 

To place a date field on the label, do the following: 

1. In the Toolbox, click the arrow  . 

2. From the list, select New Date Field. 

 
Creating new date variable field 

3. Click on the label where you want to place the object. The Date dialog box opens. 

4. Leave everything as default. The date is used on the label using the selected format. 

5. Follow the prompts.  
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Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are added to the value 
when you preview and print the label. 

To add the prefix to the variable field on the label, do the following: 

1. In the Toolbox, click the arrow . 

2. From the list, select New Time Field. 

3. On the label, click where you want to place the object. The Text Wizard dialog box 
opens. 

4. Click Next. 

5. Enter Time: for the Prefix option. 

 
Defining the variable prefix 

6. Click Finish. The text object is placed on the label and linked to the new variable. 
When you print the label, the prefix Time: will be appended to the time value on the 
left side. 
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Resize Variable Fields (Shift-dragging) 

The size of the variable fields on the label is determined by their sample data. The sample 
data is defined during the variable creation process. The text object on the label is always as 
wide as the width of the sample data formatted in the current Zebra font. 

If the values for the variable always occupy the same length or less than the sample data, the 
label is printed correctly. If the provided data is longer than the sample data, the text object 
can overlap the object to its right. 

To avoid overlapping, you can resize the variable fields on the label. 

To resize the variable fields on the label, do the following: 

1. Select the variable text object on the label. 

2. Press and hold the Shift key. 

3. Resize the object to the right. 
The new object frame defines the maximum size that the variable value can occupy on 
the label. 

Note: You can resize the object on the right side only. 

Resize Variable Field linked to Single-Line Variable 
If you resize the object linked to the single-line variable, the contents for the object is visible 
to the end of the object frame only. 
For example, you entered SAMPLE for the sample data. You then resized the object for one 
additional character to the right side. When you print the label with value DESIGNER, the 
whole text is not printed. The text that does not fit into the designed frame is cut. 

Resize Variable Field linked to Multiline Variable 
If you resize the object linked to the multiline variable, the contents of the object 
automatically reformat into the multilines. The printer reformats the text to optimally fit into 
the designed frame. 
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Design an RFID Smart Label 
Radio Frequency Identification (RFID) refers to technologies that use radio waves to 
automatically identify individual or groups of items. ZebraDesigner for XML and 
ZebraDesigner printer drivers support programming and printing of RFID tags embedded in a 
label.  

Note: You can use RFID functionality in ZebraDesigner for XML only if you have 
installed a ZebraDesigner printer driver with RFID support. 

Create RFID Encoding Label 

1. In the Standard toolbar, click . The Label Setup Wizard dialog box opens. 

2. Select the printer that supports RFID smart label printing. 

3. Click Finish. In the Toolbox, on the left side of the working window, the RFID tag 
command is enabled. 

 
RFID tag is available for use 
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Encode RFID Tag 
The RFID tags that are embedded into the label are usually one of these types:  

• ISO tags, which encode blocks of data 

• UHF tags, which can encode one string of data. 

1. To begin encoding the data, in the Toolbox, click . The RFID tag 
dialog box opens. 

 
Encoding contents for RFID tag 

2. From the Type list box on the top of the dialog box, select the type of RFID tag you 
want to use. 

3. Select the Use RFID tag in label option.  

Note: If you don’t select this option, the definition of tag content is saved but not sent to 
the printer. 

4. In the Data Block section, from the Data Type drop-down, select HEX or ASCII.    

5. Enable the Element radio button and select the desired variable.  

6. Click OK. A schematic view of the RFID tag antenna opens in the label background 
identifying the definition of the RFID data on the label. 
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RFID tag antenna in the background 

7. You can continue designing the smart label with non-RFID data as described in the 
previous sections. 

When you print the label, the RFID data is sent to the printer. The printer prints the RFID 
smart label and programs the RFID tag embedded into the label at the same time. 

Note: ZebraDesigner for XML can also work with Unique RFID tag numbers. Each 
RFID tag has an embedded unique serial number. All RFID Zebra printers can read the 
Unique RFID tag number from the RFID tag and use it on the label as data contents of 
some label object. 
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Support for RFID tags 
The concept of Radio Frequency Identification (RFID) can be simplified to that of an 
electronic bar code. First emerging in the 1980s, RFID was primarily used to track objects in 
industrial environments where bar codes were unable to sustain the harsh surroundings. 
Today, RFID is being used to authenticate official memorabilia, track proprietary assets, 
automate access control, and for many additional uses. 

Some thermal RFID printers have the ability to program an RFID tag at the same time the 
label prints. Two different technologies and their encoding methods are joined on the same 
label. Of course, a label must have an embedded RFID tag. The tag is paper thin, flexible, and 
small in size, which allows it to be placed inconspicuously under the label. It consists of an 
etched antenna and a tiny chip that can store ID numbers, or your custom data in larger 
quantities. This contrasts with a bar code label, which does not store any enhanced 
information, but merely some code numbers. 

 
RFID tag dialog box 

RFID tag data encoding options are set in this dialog box. 
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Type: Select the type of RFID tag you want to use with your printer. You must use the 
ZebraDesigner RFID driver to use RFID programming. The list of available tags changes with 
the selected printer, and not all tag types are always available. It also depends on each printer 
model and what type of RFID tags can be used with it. There are generally these types of tags: 

• ISO tags (TagIt, iCode, ISO): These are block-oriented tags. The data can be encoded 
in multiple blocks. 

• UHF tags (EPC): The data is encoded in one block of data. These tags include: Class 
0, Class 1, Class 0+, and Gen2. 

Use RF tag in label: Enable this option if you want to program the tag at the same time the 
label prints. If the option is not selected, no RFID data is sent to the printer, but the definition 
is remembered for next time. 

Tag Settings: This section provides the information about the selected tag type. For tag 
placement specification, visit www.zebra.com/RFID. 

Antenna offset: To achieve better programming accuracy of the tags this option, define 
the offset for the antenna in the printer. This is the distance from the edge of the label to 
the embedded tag. This option helps you program the tags more accurately. 

Number of retries: This option sets how many times the printer tries to program the 
tag if the first attempt fails. The parameter is sent to the printer with the rest of the data. 

Maximum tags to stop: This option sets how many consecutive tags should be tried 
before stopping if an error occurs during tag programming. If the programming error is 
still detected after the set number of labels, the printing/programming process stops. 
Enter 0, if you want to continue printing with the next label in the batch, without 
printing the label with an error. 

Check for a valid tag: The contents of the RFID tag are verified to determine the 
proper contents. 

Tag Information: This section shows static tag information based on the tag type in the Type 
drop-down. 

Number of blocks: The number of blocks that are available in the RFID tag. 

Block size: The size of each block (in bytes). 

Reserved blocks: The number of blocks that cannot be accessed and used.  

Unique RF Tag: If you have the printer and/or the tag type that can provide you with 
the Unique Tag ID, set this flag to Yes. Each tag has a unique ID encoded in the 
production line. If your printer can read this information from the tag, you can use it 
with the label elements. When the Unique Tag ID is supported, you can connect it with 
the label elements using RFID Unique Tag ID contents provider. 
For example: The printer scans Unique Tag ID, remembers it, and prints it on the label 
encoded in a bar code element. 

RFID Tag Data Read: Determines if the tag is readable.  

Data Blocks: This section allows you to provide data values for the RFID tag. This section 
has different options available for different tag types (UHF or ISO). 
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For UHF tags 

Data type: Data type of the selected tag can be specified here. 

Data source: Incoming data that is encoded in the tag can be a fixed value or acquired 
from some variable defined in the label. 

Data size: The currently used data is previewed here. You can see the amount of space 
still available in the tag. The occupancy of the tag is seen graphically with a bar and 
numerically with a digit, explaining the number of bytes being used. 

Block locked: If you set the block as locked, the data is permanently encoded into the 
tag. You are not able to erase this block to reprogram it with some other value. Use this 
option with caution! 

For ISO tags 

The blocks that are dimmed and unaccessible are reserved blocks that cannot be used. 

Block Number: The number of blocks that are available in the RFID tag. 

Data source: Select where the data block receives its value. It can be Fixed, where you 
manually type in the value or Variable, where the value is acquired from some variable 
defined in the label. 

Data: Type in the tag value manually if the selected data type is Fixed. Select the 
variable defined in the label if the selected data type is Variable. If your variable length 
is greater than the block size, the next block is automatically reserved for the data. 

Data Size: The currently used data is previewed here. You can see the amount of space 
still available in the tag. The occupancy of the tag is seen graphically with a bar and 
numerically with a digit, explaining the number of already used bytes. 

Data type: The data can be encoded as an ASCII string or as a HEX encoded string. 

Block Locked: If you set the block as locked, the data is permanently encoded into the 
tag. You cannot erase this block to reprogram it with some other value. Use this option 
with caution! 
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Change Printer Settings 
When you start designing a label, tell ZebraDesigner for XML what printer to connect the 
label to. Each label file remembers the printer settings for the selected printer driver on the 
label. 

This example shows you how to change the printing speed and darkness.  

To change the printer settings, do the following: 

1. From the menu, select File > Printer Settings. The dialog box with the printer 
settings opens. 

2. From the Options tab, change the Speed and Darkness options.  

3. Click OK. 

4. To save the label, in the Standard toolbar, click  . 

 
Printer driver properties 

Note: Any changes in the printer settings dialog box are saved to the label and applied 
to future print actions. 
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Change Dithering Type 
Dithering is a process of converting color or gray scale pictures to black and white pictures 
that can be printed on thermal printers. There are no intermediate shades of gray. 

During the dithering process, all colors and shades of gray in the picture are converted to 
black and white dots, creating the illusion of new colors and shades by varying the pattern of 
dots. Different shades of gray are produced by varying the patterns of black and white dots. 
There are no gray dots at all. In printing, dithering is usually called half-toning. Shades of 
gray are called half-tones. 

To change the dithering type, do the following: 

1. From the menu, select File > Printer Settings.  The Printer Properties dialog box 
opens. 

2. Open the Dithering tab. 

3. Enable the Dithering Type that suits your needs. Look at the preview on the right side 
to see the result of your selection on the label. 

4. Click OK. 

5. To save the label, in the Standard toolbar, click  . 
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Use Toolbars 

Use the Standard Toolbar 
Click on the buttons in the Standard toolbar to execute the following actions: 

 
Create new label. 

 
Open existing label. 

 
Save currently opened label. 

 
Cut the selected objects to clipboard. 

 
Copy the selected objects to clipboard. 

 
Paste the objects from the clipboard. 

 
Undo last action. 

 
Redo last action. 

 
Access the test print functionality. The label is quickly printed. You can 
review the positions of the objects. Click on the small arrow in the 
toolbar for more commands. 

 
Access the export functionality. The label template is parsed through 
the XML Format Generation Wizard and prepared in a format for off-
line printing. 

 
Access the zoom functionality. Click on the small arrow in the toolbar 
for more commands. 

 
Access the view functionality. Click on the small arrow in the toolbar 
for more commands. 

 
Open the help file. 
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Use the Variable Toolbar 

 
The list box contains the variables available on the label. If you have selected some variable 
object, the list box displays variables linked to that object. If no object is selected, selecting a 
variable and then clicking on the label places the new text object and links it to the variable. 

 
Create new variable using the Variable Wizard. If you click the small arrow, you 
can specify the type of the new variable. 

 
Edit the properties of the selected variable. 

Note: If you select the variable object, the variable linked to the object is 
automatically listed in the list. 

 
Delete the selected variable. 

Note: If you want to delete the variable, you must not use it on the label 
linked to label objects. 

 
Disconnect the variable from the object. The object becomes fixed but preserves 
the formatting. 
The number of characters in the object is equal to the length of the variable. This 
might be useful when you are changing the database on the label and want to 
conserve current position and format of the objects. When you re-connect the other 
database, you can link the objects to new variables. 

These are the methods to connect a variable to a fixed or variable bar code data that contains 
variable values: 

• If you have the fixed or variable bar code data already positioned on the label, select 
it, and then choose the appropriate variable in the list. 

• If the fixed or variable bar code data is not already on the label, select the variable in 
the list, and then click the label where you want the element positioned. The Text 
element appears there and is connected to the selected variable. 

• Click on the small arrow button next to the object icon in the Toolbox, select the New 
Variable option, select the variable from the list, and then click on the label. 

The Variable toolbar always shows the name of the variable that is attached to the current 
selected element. If there are two or more elements selected that do not have the same 
variable attached to it, then the variable combo box is empty. 
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Use the Toolbox 
To use the Toolbox, do the following: 

1. To select the object, in the Standard toolbox click on the applicable icon. 

2. Move the mouse over the label. Notice how the cursor has changed. 

3. To place the selected object, click on the label where you want to put the object. 

Some objects have additional shortcuts on the right side of the icon. Using these shortcuts, 
you can quickly create a new object with fixed content, create a new variable and connect it to 
the selected object, or connect the object to one already defined variable. 

Use the Text Toolbar 
You can use the text toolbar to quickly format the text objects on the label. 

 
To format text objects, do the following: 

1. To select the text object, click it. 

2. In the Text toolbar, click the appropriate shortcut button. 

3. To change the font, select the appropriate font from the list in the list box. 

Note: You can limit the display of fonts in the list. You can list all fonts on the system, 
only graphic fonts (TrueType®, OpenType®, Type1, or bitmap Windows fonts), or only 
thermal printer resident fonts. Click on the icons next to the list of fonts. 

4. To change the size of the text, click on the list with font sizes and select the 

appropriate size. To enlarge or reduce the size of the font, click   and . This 
changes the font to the next size in the list. 

Note: You can also change the font size directly on the label by resizing the text 
element with a mouse. 

5. To format the text as bold, italic, or underlined, click the appropriate formatting 
buttons. 

 
Formats the selected text in bold style 

 
Formats the selected text in italic style 

 
Formats the selected text in underline style 
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6. To change the alignment of the text object, click on the appropriate alignment buttons. 

Note: These buttons are accessible only for multiline text objects. 

 
Aligns text to the left edge 

 
Aligns text to the horizontal center 

 
Aligns text to the right edge 

Use the Design Toolbar 
The Design toolbar is used for: 

• Changing color of the objects 

• Aligning objects 

• Rotating objects 

• Arranging objects 
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Work with Objects 

Define the Text Object 

To place the text object on the label, do the following: 

1. In the Toolbox, click . 

2. Click the position on the label where you want to place the object. The Text Wizard 
dialog box opens. 

3. Define the contents for the text object. 

4. To advance to the next step of the wizard, click Next. 

5. Follow the prompts. 

6. Click Finish. 

Note: To edit the object, select it and then double-click it. The Text Wizard dialog box 
opens. 
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Define the Bar Code Object 

To place the bar code object on the label, do the following: 

1. In the Toolbox, click . 

2. On the label, click the position where you want to place the object. The Bar Code 
Wizard dialog box opens. 

3. Define the contents for the bar code object. 

4. To advance to the next step of the wizard, click Next.  

5. Follow the prompts. 

6. Click Finish. 

Note: To edit the object, select it, then double-click it. The applicable wizard dialog box 
opens. 

Define the Picture Object 

To place the picture object on the label, do the following: 

1. From the Toolbox, click . 

2. Click on the label where you want to place the picture. The Open dialog box opens. 

3. Browse for the picture on the hard disk. 

4. When you find the picture, select it. 

5. Click Open. 

Note: To edit the object later, select it, double-click it, and follow the prompts.  

Define the Rectangle Object 

To place the rectangle object on the label, do the following: 

1. In the Toolbox, click . 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag in the bottom-right direction until the object size is correct. 

Note: If you want to draw a square, grab a handle on one of the rectangle corners, 
simultaneously press and hold the Shift key, and then resize the rectangle. A square is 
drawn.  

4. To move a rectangle to a different position, select it and drag it elsewhere on the label. 

Note: To edit the object, select it, double-click it, and follow the prompts.  
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Define the Line Object 

To place the line object on the label, do the following: 

1. In the Toolbox, click . 

2. Define the line starting point by clicking the mouse at the start position. 

3. Move the cursor to the end point while holding down the mouse button. A line is 
drawn from the left to the right side of the label. 

Note: To draw a vertical line, click the starting point and then drag the cursor in the up 
or down direction. 

Define the Ellipse Object 

To place the ellipse object on the label, do the following: 

1. In the Toolbox, click . 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag to the bottom-right direction until the object size is correct. 

Note: To draw a circle, grab a handle on one of the ellipse corners, simultaneously 
pressing and holding the Shift key, and then resize the ellipse. A circle is drawn.  

4. To move an ellipse to a different position, select it and drag it elsewhere on the label. 

Define the Inverse Object 

To place the inverse object on the label, do the following: 

1. In the Toolbox, click . 

2. Click the position on the label where you want the upper-left position of the object to 
be set. 

3. Drag to the bottom-right direction until the object size is correct. 

Note: To draw a square, grab a handle on one of the rectangle corners, simultaneously 
pressing and holding the Shift key, and then resize the rectangle. A square is drawn.  

4. To move an inverse to a different position, select it and drag it elsewhere on the label. 
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Use Text Wizard 
The Text Wizard guides you to define all parameters for the text object. You can define the 
object with fixed or variable contents. 

 
First screen of Text Wizard 

Fixed text: Select this option if you want to have fixed non-changeable content in the object. 
If you select this option, you can enter the text directly in this dialog box. 

Variable text: Select this option if you want to have variable content in the object. Defining 
the content is explained in the next step. 

Font: Currently selected font type is shown in this field. 

• Inverse: Enable this option to use the text in inverse. 

Note: This option is not available for all fonts/printers. 

• Select button: Select different font types for this text object among available fonts in 
the system. 
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Text Wizard - Select Type of Variable Text 

Select the type of variable field you want to use. The next page of the wizard depends on your 
selection here. 

 
Text Wizard - Choosing variable text 



Design Labels 

45 

Text Wizard - Time Field 

Define the properties of the time field. The variable field gets the value from the computer's 
clock. 

 
Dialog box for Text Wizard when Time field option is chosen 

Format: Select the format for the time from the list. You can also enter a custom format. 

Preview: The printer prints the time as shown in the Preview field. You can see how the 
selected date format looks on the label. 

Use the printer's internal clock: Enable this option to recall the time information from the 
Real Time Clock (RTC) built in to the printer, instead of the computer's clock. The list of 
available time formats changes according to the capabilities of the selected printer. 

Note: You must format the current text object in the internal printer clock to be able to 
use the option Use the printer's internal clock. 

Only the printer internal date formats can be used with ZebraDesigner for XML. 
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Text Wizard - Date Field 

Define the properties of the date field. The variable field gets its value from the computer's 
clock. 

 
Dialog box for Text Wizard when Date field option is chosen 

Format: From the list, select the format for your date. The list defines the formats available 
internally in the printer. 

Date offset: You can add a certain number of days, months, or years to a current date and 
print that date instead of the current one. 

Preview: The printer prints the date as shown on the Preview field. This allows you to see 
how the selected date format looks on the label. 

Use the printer's internal clock: Enable this option to recall the date information from the 
real time clock (RTC) built in to the printer, instead of the computer's clock. The list of the 
available date formats changes to the capabilities of the selected printer. 

Note: You must format the current text object in the internal printer clock to be able to 
use the option Use the printer's internal clock. 

Only the printer internal date formats can be used with ZebraDesigner for XML. 
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Text Wizard - RFID Tag Contents 

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID 
tag has a unique ID number that was programmed into the tag during the manufacturing 
process. The Unique number cannot be altered, but the RFID-enabled printer can read it. 

The RFID tag Unique ID functionality allows you to read the unique ID number from the 
RFID tag and use the content with the selected bar code object. When the label is printed, the 
printer first reads the unique ID from the tag and then immediately uses the value with the bar 
code object. 

The RFID tag Unique ID can only be used with the bar code objects that are printed as 
internal printer objects. You must format the bar code object to use internal fonts, not 
TrueType fonts. 

 
The RFID Tag Contents dialog opens when you select Text > New RF Tag Unique ID 

Selected RFID tag: Select the tag from the list. 

Note: Only tags supported by the selected printer are listed. If you want to use a 
different tag type, make sure you have selected the proper Zebra printer driver. 

Read Source: This is a static drop-down menu. It's content is based on the tag type in the 
Selected RFID tag drop-down.  

Data Format: Select the format of the data. 

Preview (WYSIWYG only): Because the RFID tag's Unique ID information is not returned 
to the labeling software, you do not see the actual data. Enter the data in a format similar to 
the format encoded in the RFID tag. This information is used only for preview on the label.  
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Text Wizard - Prefix and Suffix 

The variable object can have prefix and suffix values. The prefix text is placed in front of the 
variable's value. The suffix text is placed at the end of the variable's value. 

 
Setting Prefix and Suffix string for the variable text element 

Note: If you leave the edit fields empty, the prefix/suffix is not used. 

Prefix and suffix can be used in situations where they are required only if the variable has a 
value set. If the variable is empty, the prefix/suffix is not printed. 

Note: When you use the printer's Real Time Clock for the date or time fields, the 
combined length of the prefix and suffix cannot exceed 31 characters. 



Design Labels 

49 

Use Bar Code Wizard 
The Bar Code Wizard allows you to define all parameters for the text object. You can define 
the object with fixed or variable contents. 

 
First page of Bar Code Wizard 

Fixed bar code data: Select this option if you want to have fixed non-changeable content for 
the text object. If you select this option you can enter the text directly in the dialog box. 

Variable text: Select this option if you want variable content for the text object. Defining the 
content is explained in the next step. 

Note: When entering values for RSS composite bar codes, you need to provide the 
value for the linear and composite (2D) parts at the same time. 

Use the following syntax for entering values for RSS composite bar codes. The pipe character 
(|) is used to distinguish between the components. 

Syntax: <linear part>|<composite part> 
Example: 12345|description 

Element name: Each bar code object on the label has a unique name. When you are linking 
fields together, you can refer to the Element names. 

Phantom: If the object is marked as phantom, it is visible on the label during the label design, 
but it is not printed. 

Bar Code Type: To select the bar code type you want on the label, click Define. 
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Bar Code Wizard - Select Type of Variable Bar Code 

 
Bar Code Wizard - Choosing variable text 

Select the type of variable field you want to use. 

The next page of the wizard depends on your selection. 

Bar Code Wizard - Date Field 

Define the properties of the date field. The variable field gets the value from a computer 
clock. 

Format: Select the date format from the list. You can also enter a custom format. 

Date offset: You can add a certain numbers of days, months, or years to a current date and 
print that date instead of the current one. 

Preview: The printer prints the date as shown in the Preview field. You can see how the 
selected date format looks on the label. 

Use the printer's internal clock: Enable this option to recall the date information from the 
real time clock (RTC) built in to the printer instead of the computer's clock. The list of 
available date formats changes according to the capabilities of the selected printer. 

Note: To format the current text object in the internal printer clock, use the Use the 
printer's internal clock option. 

Only the printer internal date formats can be used with ZebraDesigner for XML. 
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Bar Code Wizard - Time Field 

Define the properties of the time field. The variable field value is from the computer's clock. 

Format: Select the format for the time from the list. You can also enter a custom format. 

Preview: The printer prints the time as shown in the Preview field. You can see how the 
selected date format looks on the label. 

Use the printer's internal clock: Enable this option to recall the time information from the 
Real Time Clock (RTC) built into the printer, instead of the computer's clock. The list of 
available time formats changes according to the capabilities of the selected printer. 

Note: To format the current text object in the internal printer clock, use the Use the 
printer's internal clock option. 

Only the printer internal date formats can be used with ZebraDesigner for XML. 

Bar Code Wizard - RFID Tag Contents 

Printers with RFID functionality can program RFID tags embedded in the labels. Each RFID 
tag has a unique ID number that was programmed into the tag during the manufacturing 
process. The Unique number cannot be altered, but the RFID-enabled printer can read it. 

RFID tag Unique ID functionality allows you to read the unique ID number from the RFID 
tag and use the content with the selected bar code object. When the label is printed, the printer 
reads the unique ID from the tag and then immediately uses the value with the bar code 
object. 

RFID tag Unique ID can only be used with the bar code objects that are printed as internal 
printer objects. You must format the bar code object to use internal fonts, not TrueType fonts. 

Selected RFID Tag: Select the tag from the list. 

Note: Only tags supported by the selected printer are listed. If you want to use a 
different tag type, make sure you have selected the proper Zebra printer driver. 

Read Source: Select the source of the RFID data. To define the data from the RFID tag you 
want to use, click Detailed. 

Note: The Detailed button is not accessible for all RFID printers. 

Data Format: Select the format of the data. 

Preview (WYSIWYG only): Because the RFID tag's Unique ID information is not returned 
to the labeling software, you do not see the actual data. Enter the data in a format similar to 
the format of the RFID tag. This information is used only for preview on the label. 
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Bar Code Wizard - Prefix and Suffix 

The variable object can have prefix and suffix values. The prefix text is placed in front of the 
variable's value. The suffix text is placed at the end of the variable's value. 

Note: If you leave the edit fields empty, the prefix/suffix is not used. 

Prefix and suffix can be used in situations where they are required only if the variable has a 
set value. If the variable is empty, the prefix/suffix is not printed. 

Note: When you use the printer's Real Time Clock for the date or time fields, the 
combined length of the prefix and suffix cannot exceed 31 characters. 
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Use Graphics Wizard 
The Graphics Wizard helps you place the image on the label. You can place fixed images or 
variable images on the label. If you use variable pictures, the selected variable provides the 
path and filename of the picture. 

Note: The Graphics Wizard is not available with all ZebraDesigner editions. If there is 
no support for variable graphics in ZebraDesigner for XML, the Graphics Wizard does 
not start. You are able to browse for fixed graphics files from the disk. 

 
The first step of the Graphics Wizard 

Graphics Wizard - Variable Selection 

If you want to use variable pictures on the label, select the appropriate variable in the list. The 
variable must provide the name of the picture. 

Note: If no variables are available, click New and define a new variable. 
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Bar Code Type Selection 

Settings for Advanced Bar Codes 

EAN.UCC 128 Bar Code 

This bar code is a combination of one or more standard input values Application Identifiers 
(AID). Each AID must be followed by the standard values. These values can be fixed or 
variable. 

When you select the EAN.UCC 128 bar code, the bar code data field in the Bar Code Wizard 
dialog box is disabled.  

To define the contents of the bar code, do the following: 

1. Click Next.  

2. From the list of available AIDs, select the first identifier; it is written in brackets 
below the bar code. 

3. When the AID also includes check digits, you must define whether it is calculated or 
entered together with data. 

4. Define how you want to set the values for the selected identifier. You may enter a 
fixed value or define a variable value.  

Fixed values 

When values are fixed, the Wizard dialog box tells you what to enter.  

The defined AID is presented on the list of selected Application Identifiers.  

To work with AIDs, do the following: 

• To add a new AID, click Add.  

• To delete an existing AID, click Delete. 

• To change the AID and the data, select the AID, and click Edit. 

• To sort the listing of AID, click Up and Down.  

All of the settings can be previewed on the Preview field.  

The separator between AIDs can be defined by entering the required separator for the left and 
for the right side of the Application Identifier. The default separator is brackets. 
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Variable values 

The EAN.UCC 128 bar code supports keyboard variables – the variable data is entered from 
the keyboard. 

You can define the Prompt, which is the message for the operator who enters the data. 

• The data can be numeric only or all characters. 

• The value can be fixed or incremented/decremented on every label or a certain number 
of labels with the desired step. 

• The variable data is written in the Preview field as a series of A characters. 

• When you are satisfied with the settings, click Finish to put the EAN.UCC 128 bar 
code on the label.  

PDF 417 2D Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Security tab 

According to the standard, you can select among 9 levels of security. Higher security levels 
allow more reliable reading regardless of errors, but the bar code symbol is bigger. 

Truncated bar codes can be used where label damage is unlikely and there is no demand for a 
high level of security. The truncated symbol is smaller. 

Aspect Ratio 
It is the ratio between the number of columns and the number of rows.  

Contents 

PDF 417 code can encode: 

• Full 128 ASCII character set 

• All 128 Extended ASCII characters 

• 8-bit binary data 
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DataMatrix Bar Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Aspect Ratio 
It is the ratio between the number of columns and the number of rows. Enter the value in the 
fields. 

Details tab 

ECC Type 
Error Correction Codes (ECC) define the security level. You can select one from the standard 
levels in the pull-down menu. 

Format ID 
This option defines which character set is used in the bar code. You can select one of the 
formats with the following filter: 

01 and 11 0..9, space 

02 and 12 A..Z, space 

03 and 13 A..Z, 0..9, space 

04 and 14 A..Z, 0..9, space,.-/ 

05 and 15 7-bit ASCII lower part (from 0 to 127) 

06 and 16 all 

07 and 17 7-bit ASCII 

 

Formats 1 to 7 allow a data length up to 500 characters, while formats 11 to 17 allow up to 
2000 characters. 

Border Size 
Factors 1 to 15 set the dimension of the border in the shape of the character L. 

Data Matrix can encode: 

• Full 128 ASCII character set 

• All ISO characters 

• All EBCDIC characters 
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MaxiCode 2D Code 

General tab 

Y expansion factor 
This option defines the height of the bar code symbol. 

Details tab 

When the Structured option is not selected, the content of the bar code is optional.  

For a Structured bar code you can encode only standard contents. 

Edit Bar Code Dialog Box 

This dialog box is displayed when you click the Define button in the Bar Code dialog box. In 
this dialog box, you specify the type of bar code you want to use on the label and all 
additional advanced settings: how the bar code should be generated, if the check digit should 
be automatically calculated or not, and various other options. If the Enable preview check 
box is checked, a preview of the resulting bar code appears on the right side of the dialog box. 

When you are satisfied with the bar code properties, click OK to confirm the changes made, 
or click Cancel to reject them and keep the previous settings. 

The Edit Bar Code dialog box has several pages (tabs). 
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General Tab 

On this tab you can select the bar code type you want to use and the properties of the bar 
code. 

 
Edit Bar Code dialog box – General tab 

Available bar codes: The required bar code symbology is selected from the tree list of 
available bar codes. 

Symbol height: The height dimension of a bar code can be specified either by entering a 
value here or by resizing the bar code symbol directly on the label. 

X Expansion factor: The expansion factor defines the width of the bar code symbol. 

Ratio: This is the ratio between the narrowest and the widest bar in the bar code. It is locked 
for the majority of bar codes, but it can be changed for some. 

Base object width (mils): Shows the width of the narrowest bar in the bar code in mils. 

Print bar code as a graphic: Select this if the bar code should be converted to a picture and 
sent to the printer as an image, or if the bar code should be printed as an internal element. 
Printing internal bar codes speeds up label printing because less data is transferred to the 
printer. 

Note: If the printer does not support the selected bar code internally, the Print bar code 
as a graphic option is not available. All office printers print bar codes as pictures. 
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Check Digit Tab 

This tab is used to specify if you want to use the check digit in the bar code. This option can 
be modified only for the bar codes that allow you to enable and disable the check digit. 

Some bar code standards include the check digit by definition and it cannot be omitted. An 
example of such bar codes is EAN and UPC bar codes, where the check digit cannot be 
disabled. Some bar codes allow you to freely enable or disable the check digit. 

Note: We recommend that you always include the check digit character in the bar code. 
It increases the scanning reliability. 

 
Edit Bar Code dialog box – Check Digit tab 

You can choose whether you want to input the check digit value, or let the program calculate 
it for you: 

Auto-generate check digit: Check digit is calculated by the software. You enter the 
bar code data only. For example: when using the EAN-13 bar code, you enter the first 
12 digits; the check digit on the 13th place is calculated and added automatically. 

Verify the provided check digit: Use this command when you want to enter the value 
for the check digit. At print time, the entered check digits are verified for validity. 

Enable custom check digit algorithm: You can set a custom algorithm for calculating 
the check digit. To choose the algorithm, click Select. 
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Human Readable Tab 

On this tab, you can set the options regarding position and format of the bar code 
interpretation. 

No interpretation: Bar code objects do not have human interpretation. 

Below bar code: All data encoded in the bar code is placed beneath the bar code 
symbol as human readable characters. 

Above bar code: All data encoded in the bar code is placed above the bar code symbol 
as human readable characters. 

Font: Using the Font button, you can choose the font for auto-translation text. The 
Auto font scaling option adjusts the font of the auto translation text to the size of the 
bar code. 

Note: You can format the font for human interpretation only if the bar code is printed as 
a graphic. When printing the bar code as an internal printer object, the printer prints the 
interpretation using resident built-in fonts. 

Contents Mask: sets the custom format of the human interpretation. 

 
Edit Bar Code dialog box – Human Readable tab 
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Details Tab 

On this tab you can define advanced settings for the bar code: 

Note: Not all of these options are available for all bar codes and printers. 

Include quiet zones: Check this field if you want the bar code to have some white 
space in the front and in the back. This improves readability. 

Descender bars: Some bars of a bar code are longer than others. This is typically used 
with EAN and UPC bar codes that have longer bars in the beginning, in the middle, and 
in the end of the bar code. 

Mirror horizontally/Mirror vertically: The bar code can be mirrored vertically and 
horizontally. The bar code usually has to be printed as a graphic for this option to be 
accessible. 

Intercharacter gap: Some bar codes allow you to change the gap between characters 
in the bar code (for example Code 39). 

Include EAN white space: Before and after the bar code, a special character is 
inserted. It indicates the width of the bar code. If you put any other object in the area of 
the bar code, it reduces the readability of the bar code. This option is valid only for 
EAN bar codes. 

 
Edit Bar Code dialog box – Details tab 
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Supported Bar Code Types 

Bar code 
Group 

Bar code Types 

EAN and 
UPC 

EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, 
EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit 
supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 
2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 
2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), 
EAN.UCC 128, SSCC, Bookland, Addon 2, Addon 5 

Linear Interleaved 2 of 5, ITF 14, ITF 16, Code 39, Code 39 Tri Optic, 
Code 39 Full ASCII, Code 32, Code 93, CODE 128 (A, B and C 
subsets), MSI, Codabar, Postnet-32, Postnet-37, Postnet-52, 
Postnest-62, Kix, Pharmacode, Plessy, Anker 

RSS Linear RSS symbologies 
RSS14, RSS14 Truncated, RSS14 
Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS 
Expanded 
Composite RSS symbologies 
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked 
Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, 
EAN-8, EAN-13, EAN.UCC 128 & CC-A/B, EAN.UCC 128 & CC-
C 

Two-
dimensional 

2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR, 
MicroQR, Codablock F, MicroPDF, InfoGlyph 
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Select Objects 
To select the object on the label, do the following: 

1. In the Toolbox, click . 

2. Click the object on the label that you want to select. 

3. To select two or more objects, press and hold down the Shift key while clicking the 
object with the mouse. 

The objects can be selected, cut, copied, pasted, and edited with the right mouse button. If you 
click the right mouse button on the object, the menu shows all available commands. Note that 
these commands are equivalent to corresponding menu commands. 

You can change the anchoring point of a selected object by holding down the Ctrl key while 
clicking the placeholders (corners of the bounding box) of the object. 

Edit Objects 
To edit the properties of the object, do the following: 

1. Double-click the object on the label. The Object dialog box opens. 

Note: If  the object is selected, you can also press Enter. 

2. Make modifications to the object properties. 

3. Click Finish. 

Move Objects 
To move the object on the label, do the following: 

1. Select the object. 

2. Click on the object with the left mouse button. 

3. Hold the mouse key down. 

4. Move the position of the cursor on the screen. The object moves with the cursor. 



ZebraDesigner for XML User Guide 

64 

Align Objects 
To align objects on the label, do the following: 

1. Select the objects that you want to align. 

Note: All objects are aligned relative to the first selected object. 

2. To align selected objects to each other, in the Design toolbar click the appropriate 
buttons. If the Align toolbar is not visible (by default it is on the right side of the 
window), from the menu, select View > Toolbars. Make sure Design is enabled.  

Note: Alternatively you can right-click the objects on the label and select Align 
command. 

You can align objects to: 

 Left 

 Right 

 Center 

 Top 

 Bottom 

 Vertical center 

You can also distribute objects evenly so that spacing between them is equal: 

 Horizontally Space Equally 

 Vertically Space Equally 

Note: If you hold the CTRL key while clicking the buttons, objects are aligned relative 
to the label and not to the first selected object. 
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Resize Objects 
To resize the object on the label, do the following: 

1. Select the object. The selected object is framed with a rectangle. 

2. Click on one of the small rectangles in the corners of the rectangle. 

3. Hold the mouse key down. 

4. Move the position of the cursor on the screen. The object resizes with the cursor. 

Rotate Objects 
To rotate the object, do the following: 

1. Select the object. 

2. In the Design toolbar, click . The object is rotated 90° clockwise. 

Note: If the Design toolbar is not visible in the application, to enable it, from the menu 
 select View > Toolbars. 
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Supported Graphics Formats 
These are the supported graphical formats: 

File extension Graphics type 

BMP, DIB, RLE Windows Bitmap 

GIF CompuServer Bitmap 

JPG, JPEG, JPE JPEG Bitmap 

TIFF, TIF, FAX, 
G3N, G3F 

TIFF Bitmap 

PNG Portable Network Graphics 

WMF Windows Metafile 

EMF Enhanced Windows Metafile 

ICO Windows Icon 

CUR Windows Cursor 

TGA, TARGA, 
VDA, ICB, VST, 
PIX 

Targa Bitmap 

PXM, PPM, PGM, 
PBM 

Portable Pixmap, GreyMap, 
BitMap 

JP2 JPEG2000 

J2K, JPC JPEG2000 Code Stream 

PCX Paintbrush 

 



Design Labels 

67 

Work with Variable Data 

Dynamic Data Overview 
You may want to print labels where the data changes for each label, for example, serial 
numbers, date, and time. To accommodate the changing data, ZebraDesigner for XML can be 
used to format labels using the variable fields. Variable fields can be used with text and bar 
code objects. 

There are several types of variables you can choose. The data for the variables must be 
provided before the label can be exported:  

• Before the label can be printed, you must provide the values for the variables. 

• The data is provided from the printer’s clock for the date and time fields (internal 
printer RTC). 

• The data is provided from the RFID tag embedded in the label (RFID tag Unique ID). 

Create Single-Line Variable 
As the name suggests, you can use a single-line variable in one line of text on the label. 

To create a single-line variable on your label, do the following: 

1. Make sure the Variable toolbar is visible. If it is not, select View > Toolbars > 
Variable. 

2. In the Variable toolbar, click . The Variable Wizard dialog box opens. 

3. Enter the name of the variable. Use a descriptive name so that you know what the 
variable contains. 

4. Click Next. 

5. Enter the Sample data. When you link your variable to the label object, the sample 
data will be used for the contents of the object. The sample data is shown during label 
design only. 

Note: When you print the label, the variable uses the data you provide, not the sample 
data. 

6. Click Finish. 
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Create Multiline Variable 
As the name suggests, you can use a multiline variable with more lines of text in the text 
object on the label. The variable can contain as many characters in each line as you specify. 
The total amount of allowable characters is the number of characters per line, times the 
number of lines. For example, if you allow 20 characters in a line and have 5 lines, the total 
number of characters is 100. 

To create a multiline variable on your label, do the following: 

1. Make sure the Variable toolbar is visible. If it is not, select View > Toolbars > 
Variable. 

2. In the Variable toolbar, click . The Variable Wizard dialog box opens. 

3. Enter the name of the variable. Use a descriptive name so that you know the variable 
contents. 

4. Click Next. 

5. Enable the Multiline Variable option. 

6. Enter the Sample data. 
When you link your variable to the label object, the sample data is used for the 
contents of the object. The sample data is shown during label design only. Use the 
Enter key to advance to the next line of text. 

Note: When you print the label, the variable uses the data you provide, not the sample 
data. 

7. Click Finish. 
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Control Text Field Widths and Multiline Fields 
Sometimes you may want to control the width of the variable text field. This is useful for 
ensuring correct text alignment and justification. At print time, if the width of the field set on 
the label template is not large enough, the text may word wrap on itself on the same line. This 
results in what looks like corrupt data.  

To control the field width, do the following: 

1. While holding down the Shift key, drag the middle right handle of the field. This 
method establishes the width of the text object frame. Once a field has been set using 
this method, it is easy to use the justification buttons in the Standard toolbar to set left, 
center or right justification for the field. 

Another method is necessary when creating multiline variable fields.  

To set up the Sample data in the Variable Wizard, do the following:  

1. From the menu, click .  

2. In the Sample data text box, type the name of the variable and click Next. The 
Variable properties dialog box opens: 

  
Variable Wizard dialog box 

3. To establish a multiline variable type, click the Multiline Variable check box. The 
Number of Lines value increases each time you press the Enter key while entering 
your Sample data. When used as a Text Field variable, a Multiline variable will result 
in a field that uses the number of lines you defined in the variable. In this method you 
can also use the justification buttons in the design environment to set left, center, or 
right justification for the field. 
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This is an example of a field that has been set to a controlled width using the Shift-dragging 
method, and then set to center justification. At print time, data sent to this field will occupy 
the defined width, in a center justification: 

 
 This is an example of a field that has been created using a multiline variable and set to left 
justification: 

 
These two methods can be used together to create variables fields with known width, 
multiline, and justification properties as shown below: 

 
Note: This method requires the use of a font that is internal to the printer, such as the 
scalable Zebra Font 0 or Zebra Swiss Unicode.  
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Using Printer Real Time Clock (RTC) 
When the printer selected on the label has a built-in Real Time Clock (RTC), you can use the 
time or date fields from the Real Time Clock with text objects on the label. The available time 
and date formats are defined in the printer driver. 

To use the time field from the printer RTC on the label, do the following: 

1. In the Toolbox, click . 

2. Click the position on the label where you want to place the object. The Text Wizard 
dialog box opens. 

3. Enable the Variable text option. 

4. Click Next. 

5. Select the Time Field option. 

6. Click Next. 

7. Select the appropriate time format from the list. The printer driver provided the 
software with the list of available time formats. You cannot define your own time 
format. It is determined by the printer functionality. 

8. Click Finish. 

Note: When you are using a prefix and suffix with the Real Time Clock field on the 
label, make sure that the combined length of the prefix and suffix does not exceed 31 
characters. When you are using a linked field and are merging a Real Time Clock field 
with other fields, make sure that the combined length of fields surrounding the Real 
Time Clock field does not exceed 31 characters. 
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Use Variable Wizard 

Variable Wizard 

Use the Variable Wizard to create and manage the variables in the label file. When you assign 
a value to the variables, the same value is used with all objects on the label that are linked to 
the variable. 

The variables can be linked to Text and Bar Code objects. 

To create a variable follow the prompts. 

Define Variable Name 

You can define the variable name and quantity information in this step of the Variable 
Wizard. 

Variable Name: Type in the variable name. The variable name is included in the exported 
label. Make sure you use the proper variable name that is recognized by the XML Format 
Generation Wizard. 

Note: Make sure you include the proper characters for the variable left and right tag 
characters. These characters define the beginning and end of the variable name. Use the 
tag characters as suggested by ZebraDesigner for XML. For example, for the left tag 
character "%" may be suggested, and for the right tag character "&" may be suggested. 

This is a special variable: If the value of the variable contains the quantity information that 
must be included in the exported label format, click this option. 

Use var for Print Quantity: The variable identifies how many labels print. When you 
export the label format, the exported file has this variable included with the print 
command for label quantity. 

Use var for Copy Quantity: The variable identifies how many identical label copies 
print. When you export the label format, the exported file has this variable included 
with the print command for label copies. 

Use var for Cut Quantity: The variable identifies how many labels are printed before 
the printer pauses. When you export the label format, the exported file has this variable 
included with the cut command. 

Note: The Use var for Cut Quantity option is available only when the selected printer 
has the option to use the cutter. 
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Define Variable Properties 

You can define the variable data properties in this step of the Variable Wizard. 

Sample data: Enter the appropriate data for the variable. The entered data will be used for 
design and preview functionality. You will assign the variable with its proper value outside of 
ZebraDesigner for XML. 

Multiline Variable: If you want to enable multiline functionality for the variable, click this 
option. You are able to enter more than just one line of sample data. 

Note: To move to the next line of text, press the key combination Ctrl+Enter. 

Maximum number of characters: Define the maximum number of characters that the 
variable can occupy. The number defined must correspond to the external application that will 
actually set variable values. 

Number of lines: Define the multiline variable. Enter the number of lines the variable can 
occupy. 

To find out the total number of characters the variable can contain, multiply the maximum 
number of characters in a line by the number of lines. For example: if you have 10 characters 
in one line and have defined 3 lines of data, 30 characters can be set to the variable. 

Define Script 

You can define a script that is included in the exported label format. This feature is optional. 

The XML Format Generation Wizard in ZebraDesigner for XML includes the variable in the 
proper formatting in the exported label file. You can override the default settings and include 
some special parameters or commands with the variable name. Define a script and include not 
only the variable name in the script but other parameters and commands using Zebra 
Programming Language (ZPL). 

Note: This feature is for advanced users only. You must be familiar with ZPL to 
successfully use the script option. 

Use script: Click this option to enable the script option. Write your script in the provided 
space. Make sure you include the variable name in the script. 
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Export Labels 

Test Print Labels 
To test print the label, do the following: 

1. Make sure your printer is connected to the computer. 

2. Make sure the printer is online and available for printing. 

3. In the Standard toolbar, click  to quickly print your label. 

Note: The variables are assigned with a default value, but you get an overview if the 
label is designed correctly and if the objects fit on the label. You also see how the 
pictures are processed and printed. When you place a picture on the label, in design 
mode it is always shown in color-depth as defined in the picture. 

When printing the labels, the preview of the pictures depends on the dithering option set in 
the printer driver. All color pictures (except WMF and EMF files) are converted to 
monochrome images. The illusion of colors and shades of grey is accomplished by varying 
the pattern of dots. More dots close together provide a darker shade of grey. 

The test print of the label show pictures in the same way as they are printed according to the 
dithering setting. If the picture is not printed as you want it, change the dithering setting in the 
printer driver. 
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Export to Printer 
During the label design make sure the label is printed correctly. To verify the printout of your 
label, from the menu, select File > Test Print. When you are satisfied with the designed label, 
you can export the label to the printer. During the export process, ZebraDesigner for XML 
runs the XML Format Generation Wizard and converts the label format to a supported Zebra 
printer. 

The generated file includes commands from the Zebra Programming Language (ZPL) and is 
ready to be used in the printer for off-line printing. 

Note: Off-line printing is a term that describes the type of label printing where the label 
design application is not available at print time. Usually the label format is stored in the 
memory of the printer and can be recalled. Off-line printing support is great for print 
requirements where the PC computer cannot be included in the label printing process 
either because of unacceptable working conditions or logistic issues. 
Off-line printing also provides faster label printing because all variable objects on the 
label use internal printer functionality. 

To export the label to printer, do the following: 

1. From the menu, select File > Export to Printer. The Stored Format Settings dialog 
box opens.  

 
Stored Format Settings dialog box 
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2. Fill in the Printer Storage Location and Format Name fields, and then click Next. 
The Test XML File Settings dialog box opens.  

 
Test XML File Settings dialog box 

3. Make your selections and then click Next. This confirmation dialog box opens: File(s) 
created successfully.  

4. Click OK. The Destination dialog box opens.  
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Destination dialog box 

Your destination choices include:  

• Use Current Location 

• Send to IP Address 

• Send to File 

5. From the Destination dialog box, enable your desired destination and then click Next.  

Use Current Location 
If you chose Use Current Location, this confirmation dialog box opens: The format has been 
transferred. The XML test file can now be sent.  

To send the files to the printer using the port that the ZebraDesigner driver is using, do the 
following: 

1. To send, click Send File.  
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Send to IP Address 
If you chose Send to IP Address, the Select Network Destination dialog box opens.  

To complete the IP address search, you can enter an IP address or an address range.  

Examples: 
• To send a discovery request to 10.3.5.20 only, enter: 10.3.5.20 
• To send a discovery request to printers in the address range of 10.3.5.20 through 
10.3.5.47, enter 10.3.5.20-47 

The IP address search avoids sending unnecessary traffic to non-printing devices.  

To send to an IP address, do the following:  

1. In the Select Network Destination dialog box, in the Enter an IP Address field type 
in a valid IP address, or a partial address using an *. 

 
Select Network Destination dialog box 

2. Click Next. This confirmation dialog box opens: The Format has been transferred. 
The XML file can now be sent.  

3. Click Send File. The file is sent.  

4. Click Finish. 
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Send to File 
If you chose Send to File, the File Destination dialog box opens.  

To send a file to a specific destination, do the following:  

1. From the File Destination dialog box, click Browse and navigate to the location you 
want the file to go.  

 
File Destination dialog box 

2. Click Next. This confirmation dialog box opens: The Format has been saved.  

3. Click OK. 
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File Destination 
If you enable Send to File from the Destination dialog box, the File Destination dialog box 
opens.   

To choose a file destination, do the following: 

1. Click Browse. The Browse for Folder dialog box opens.  

 
Browse for Folder dialog box 

2. Navigate to the path where you want the file sent.  

3. Click OK.  

The Browse for Folder dialog box closes and you return to the File Destination dialog 
box. The Enter Destination Path text-box is populated with the destination you 
selected in the Browse for Folder dialog box.  

4. Click Next. The Format has been saved dialog box opens.  

5. Click OK.  

The Browse button in the File Destination dialog box allows you to navigate to the location 
you want the file sent.  
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Local Broadcast  
Local broadcasts send a discovery request to the local broadcast address of 255.255.255.255. 
This request finds printers in the same local network as the requesting computer.  

The local broadcast search populates itself. 

To perform a local broadcast search, do the following: 

1. From the Select Network Destination dialog box, click Search Print Server. 

2. In the Search Type dialog box, enable Local Broadcast. The Value field is 
automatically populated.  

 
Search Type dialog box 

3. Click Add. The Value field is added to Search type. 

4. Click Next. The Select Print Server dialog box opens.  

5. Using the buttons between the two panels, select the print servers you want.  

6. When you are finished, click Next. This confirmation dialog box opens: The Format 
has been transferred. The XML test file can now be sent.  

7. To send, click Send File.  
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Subnet Search 
The subnet search sends a discovery request to each address in the specified subnet. This 
feature is useful for networks that prevent broadcast packets from passing across routers. The 
Subnet search requires you to type in the first three subnet octets.  

Example: A request to 192.168.2.* sends a request to: 192.168.2.1 through 192.168.2.254. 

To perform a subnet search, do the following: 

1. From the Select Type dialog box, enable Subnet.  

2. In the Value field, type the first three subnet octets. Then type an *. 

3. Click Add, and then click Next.  The Select Print Server dialog box opens.  

4. Using the buttons between the two panels, select the print servers you want.  

5. When you are finished, click Next. This confirmation dialog box opens: The Format 
has been transferred. The XML test file can now be sent.  

6. To send, click Send File. 
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Directed Broadcast 
Directed broadcasts send a discovery request to the broadcast address of the specified subnet. 

Note: If a broadcast search does not work, the broadcast packets might be disabled 
across routers. Try multicast or subnet search.  
Example: The directed broadcast search requires you to type in the first three subnet 
octets, followed by 255, such as 192.168.2.255. 

To perform a directed broadcast search, do the following: 

1. From the Select Type dialog box, enable Subnet.  

2. In the Search Type dialog box, enable Directed Broadcast. The Value field is 
automatically populated.  

3. Click Add.  

4. Click Next. The Select Print Server dialog box opens.  

 
Select Print Servers dialog box 

5. Using the buttons between the two panels, select the print servers you want.  

6. When you are finished, click Next. This confirmation dialog box opens: The Format 
has been transferred. The XML test file can now be sent.  

7. To send, click Send File. 
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Multicast 
Multicast uses the multicast address to send a discovery address to all Zebra printers across as 
many routers as the hop count specifies. A multicast search may return a large number of 
printers in some installations. 

On some routers, this feature might be disabled. See your network administrator to determine 
if a search failure was due to this feature being disabled.  

To perform a multicast search, do the following:   

1. In the Search Type dialog box, enable Multicast (Hops). The Value field is 
automatically populated.  

2. Click Add.  

3. Click Next. The Select Print Server dialog box opens.  

 
Select Print Servers dialog box 

4. Using the buttons between the two panels, select the print servers you want.  

5. When you are finished, click Next.  

6. This confirmation dialog box opens: The Format has been transferred. The XML test 
file can now be sent.  

7. To send, click Send File. 
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Optimize the Printing Speed 
There are many factors that affect the printing speed. By following the guidelines below, you 
can dramatically increase the printing speed: 

• Use the printer's internal fonts instead of Windows TrueType fonts. TrueType fonts 
must be sent to the printer as graphics and the size of the file is much bigger 
(kilobytes). When using internal fonts, only the text is sent to the printer (a couple of 
bytes). If you must use true-type fonts, use the ZebraDesigner Font and Graphics 
Downloader program to download these fonts to the printer's memory and access these 
fonts as internal printer fonts (only available if your printer supports download of the 
fonts). 

• When using bar codes, do not print bar codes as graphics if ZebraDesigner for XML 
supports printing bar code. 

• Set the printing speed to a higher value (if your printer supports it). Note that setting 
the printing speed affects the print quality. The higher the speed, the lower the quality. 
You need to find an acceptable compromise for this. 

• Don't print too much data on labels. If the speed of printing is an important factor, you 
should consider using preprinted labels, and print only the data that is different on 
each label. 
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Glossary of Terms 

Auto translation 

Bar code interpretation of human readable characters. 

Darkness 

The printhead temperature defines the print darkness. The higher is the temperature is, the 
darker the printout (thermal printers only) is. 

Descender bars 

The first and last bar is longer in the EAN 13 bar codes. 

Quiet zone 

This is the empty place before and after the bar code symbol. This is necessary for the bar 
code reader to properly read the bar code. 

Security 

This is the definition of the control check digit with some bar code types. 
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